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Legal information

Delair SAS

www.delair.aero

Delair reserves the right to make changes to specifications
and product descriptions contained in this document at any
time without notice. Please consult the Delair community
platform (https://mydelair.com) for the latest release.

Copyrights and trademarks

Copyright © 2018, Delair SAS. All rights reserved.

Delair and its logo are trademarks of Delair SAS registered in
France and in other countries.

Android™ is a trademark of Google LLC.

Microsoft and Windows are either registered trademarks or
trademarks of Microsoft Corporation in the United States
and/or other countries.

Wi-Fi is a registered trademark of the Wi-Fi Alliance.

All other trademarks are the property of their respective
owners.

You may not use or register, in whole or in part, registered
trademarks without express authorization from their
respective owners.

Legal notices

Taiwan - Battery Recycling Requirements

The product contains a removable lithium polymer battery.
Taiwanese regulations require that waste batteries are
recycled.

廢電池請回收

Waste Electrical and Electronic Equipment (WEEE)

For product recycling instructions and more information,
please fill in a contact form at www.delair.aero or mail a
request for recycling instructions to:

Delair

676 rue Max Planck

31670 Toulouse-Labège

France

FCC Declaration of conformity

We, Delair SAS, located at 676 rue Max Planck, 31670
Labège, France

Declare under sole responsibility that DoC products comply
with Part 15 of FCC Rules.

Operation is subject to the following two conditions:

(1) This device may not cause harmful interference, and

(2) This device must accept any interference received,
including interference that may cause undesired operation.

Any changes or modifications to this equipment not
expressly approved by DELAIR may cause, harmful
interference and void the FCC authorization to operate this
equipment.

This equipment has been tested and found to comply with
the limits for a Class B digital device, pursuant to part 15
of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a
residential installation. This equipment generates, uses and
can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause
harmful interference to radio communications. However,
there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be
determined by turning the equipment off and on, the user
is encouraged to try to correct the interference by one or
more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and
receiver.

• Connect the equipment into an outlet on a
circuit different from that to which the receiver is
connected.

• Consult the dealer or an experienced radio/TV
technician for help.

This equipment complies with FCC’s radiation exposure
limits set forth for an uncontrolled environment under the
following conditions:

• This equipment should be installed and operated
such that a minimum separation distance of 20cm
is maintained between the radiator (antenna) and
user’s/nearby person’s body at all times.

• This transmitter must not be co-located or operating
in conjunction with any other antenna or transmitter.
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CE Declaration of conformity

We, Delair SAS, located at 676 rue Max Planck, 31670
Labège, France

Declare under our sole responsibility that the product
described above is in conformity with the essential
requirements of the European directives:

• 2014/53/EU (Radio Equipment Directive - RED)

• 2014/30/EU (ElectroMagnetic Compatibility Directive
- EMCD)

• 2014/35/EU (Low Voltage Directive - LVD)

• DIRECTIVE 2014/35/EU

• 2011/65/EU (RoHS 2)

• EN 62311:2008

Industry Canada’s license-exempt RSSs

This device complies with Industry Canada’s license-exempt
RSSs. Operation is subject to the following two conditions:

• This device may not cause interference, and

• This device must accept any interference, including
interference that may cause undesired operation of
the device.

This equipment complies with RSS102’s radiation exposure
limits set forth for an uncontrolled environment under the
following conditions:

• This equipment should be installed and operated
such that a minimum separation distance of 20cm
is maintained between the radiator (antenna) and
user’s/nearby person’s body at all times.

• This transmitter must not be co-located or operating
in conjunction with any other antenna or transmitter.

China - Reminder before first use

初次使用前提醒

在第一次使用无人机前，拥有人应当在无人机实名登记系统
https://uas.caac.gov.cn 中进行实名登记。信息填报后，系统
自动给出包含登记号和二维码的登记标志图片，并发送到登
记的邮箱。请将登记标志图片打印在包装中提供的不干胶贴
牌上。最后，登记标志图片应当粘贴在机身中电池预留位置
EPP泡沫材料上。

注意 : 不实名登记或不按要求粘贴登记标志图片而擅自飞行
有可能会被追究法律责任。

Before the first flight, the owner shall register this
system on https://uas.caac.gov.cn, a CAAC (Civil Aviation
Administration of China) online real name registration
platform. After having fulfilled information online, the owner
will receive by email an image consisting in a registered
number and a 2D barcode. This image should be printed on
a sticker provided in the package and then attached to the
EPP foam underneath the battery in the UAS body.

Please note: The owner is held responsible for any legal
consequence if he or she fails to fulfill the above obligations.
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General caution

Keep this manual accessible, so you can refer to it at any time.

The information and specifications included in this publication were in effect at the time of approval
for printing. Delair reserves, however, the right to make changes to specifications and product
descriptions contained in this document at any time without notice and without incurring any
obligation whatever.

A few words about safety

Your safety and the safety of others is very important, and using this aircraft safely is an important
responsibility.

To help you make informed decisions about safety, we have provided operating procedures and other
information on labels and in this manual. This information alerts you of potential hazards that could
hurt you or others.

Of course, it is not practical or possible to warn you about all the hazards associated with operating
or maintaining an aircraft. You must use your own good judgment. This entire book is filled with
important safety information—please read it carefully.

Avoid rotating propellers

Rotating propellers can cause serious cuts and even amputate fingers. Keep away from the propeller
whenever you are handling the aircraft. If you find it necessary to work on the propeller always remove
the battery first.

A long press on the aircraft Power button will deactivate the motion of the propellers.

Battery warning

Do not use any other battery or charger than the ones delivered with the system. The use of an
unqualified battery or charger may present a risk of fire, explosion, leakage or other hazard.

Stay away from hot parts

The UX11 heatsink and Delair Link metallic casing can become very hot during operation and remain
hot for a while after stopping. Contact with these parts can cause burns. Always be very cautious when
handling them.

Keep the operating area clear

The pilot is responsible of the security of people and animals that are in the operating area. Always
make sure that the area is clear before attempting any takeoff or landing operation (for details, see
Obstacle clearances on page 22).
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1 Introduction

1.1 The UX11 system

The Delair UX11 aircraft is an unmanned aerial vehicle (UAV) that is operated remotely.

The aircraft follows a pre-programmed path where takeoff, flight, and landing require minimal human
intervention.

It is equipped with an industrial camera with optional PPK activation for survey-grade results down
to 1 cm precision and can cover operationnally 1.2  km² (300 acres) with 1.7  cm GSD at 122 m flight
height.

The aircraft uses BVLOS-ready communications. The mobile connectivity via a 3G network allows for
unlimited range. Additionally, the Delair Link radio link can also be used for communication between
the aircraft and the tablet.

The aircraft can perform precise steep (30 degrees) takeoffs and landings for use in confined areas.
Landings are executed at low speed through the use of distance-measurement technology.

The easy-to-use Android™ Delair Flight Deck application with its modern user interface allows for
quick mission planning (such as indication of no-fly zones) and monitoring the flight. A pre-flight
checklist helps you to prepare the UX11 aircraft for a successful flight.

If required, the operator can intervene to change the flight path or to land the aircraft. In case of
communications failure or loss of GNSS signal, a pre-programmed intervention is automatically
activated to re-establish signal loss or to terminate the flight early and complete a safe landing.

1.1.1 Typical applications

Standard image acquisition can be used for:

• Orthophoto creation

• Digital Elevation Model (DEM) or Digital Surface Model (DSM)

• Photogrammetry

The resulting data is useful for a range of applications, including:

• Mapping and Geographic Information System (GIS)

• Surveying

• Construction

• Environmental and conservation

• Surface mining

• Aggregates

• Public land management

• Landfill management
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1.1.2 ISA conditions

All the operating specifications provided in this guide for the UX11 aircraft are determined using
International Standard Atmosphere (ISA) conditions. Applicable conditions are:

Specifications Value

Humidity 0 %

Air pressure 1013.25 hPa (760 mm Hg)

Temperature 15 °C (59 °F)

Air density 1.225 kg/m³ (0.076 lb/ft³)

1.2 Project phases

The typical phases of a mission are:

• Background map definition:

In the office you can prepare the background map. You can add details such as avoidance
zones.

• Area definition:

Define one or more areas to be photographed from the air.

Note
Once in the field, you must validate the area properties to take into account the actual environment.

• Flight definition:

Prepare one or more flights to cover the area(s) and suggest the takeoff and landing locations.

You can specify the planned direction the aircraft will fly over the area(s) in the office.

Note
If the flight preparation is done in the office, you must validate the flight properties in the field,
including the selected takeoff and landing locations.

• Flight scheduling:

This is completed outside of the Delair Flight Deck application. Flight scheduling includes:

– Check for flight permissions, weather, and site suitability.

– Schedule the flight.

– Before heading to the site, check all the equipment for any damage from previous
flights and fully charge all the batteries.

• Flight operation:

– Assemble the aircraft.
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– Complete the flight checklist to ensure that the system is ready for the flight.

– After launching the aircraft, monitor the flight using the Delair Flight Deck application.

– After the aircraft has landed, complete the post-flight checklist.

– Dismantle the aircraft.

• Analysis and export (using Delair After Flight):

– Analyze the flight and the captured images to make sure they are synchronized.

– Export the data in the appropriate file format for image processing.

• Image processing:

Process the data collected during the flight using image processing photogrammetry software.
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2 System components

2.1 UX11 aircraft

2.1.1 Top view

The UX11 consists of the following parts:

N° Description N° Description

1 Right wing 5 Pitot tube

2 Fuselage 6 Battery

3 Left wing 7 Belly plate

4 Connecting rod    

2 1 3

45

6

7
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2.1.2 Bottom view

N° Description N° Description

1 Height sensor aperture 2 Camera aperture

1 2

2.1.3 Buttons and LEDs

The figure below shows the buttons and LEDs on the UX11 aircraft.

POWER 
BIND 
CHECKLIST 
TAKEOFF

1 2

Buttons

1 Power button

2 Confirm button

LEDs

LED Status Description

Solid red Battery is plugged in and the aircraft is switched off

Blinking green Booting sequence in progress

POWER

Solid green The aircraft is powered up
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LED Status Description

Slow blinking green Ready for binding sequence

Fast blinking green Waiting for user to confirm binding by pressing
Confirm button

BIND

Solid green Binding OK

Blinking green Checklist in progress

Solid red Error detected during checklist

CHECKLIST

Solid green All checks have been completed

Blinking green Waiting for user to confirm takeoff by pressing
Confirm button

TAKEOFF

Solid green The aircraft is ready for takeoff

Note
When performing maintenance operations on the aircraft, all LEDs blink green.

2.2 Tablet

2.2.1 Requirements

• Operating system: Android 6 ("Marshmallow") to Android 9 ("Pie")

• Screen:

– 8 inches or higher

– Screen designed for outdoor use (under direct sunlight), with appropriate brightness
and anti-glare protection

• Storage: 8 GB or higher

• Internal memory: 1.5 GB or higher (2 GB is recommended)

• GPS sensor: Recommended since Delair Flight Deck application uses the Tablet GPS location
(when available) for non-mandatory features.

• Networking/communications:

– 3G-capable

– Wi-Fi 802.11 a/b/n or ac, supporting both the 2.4 GHz and 5 GHz Wi-Fi bands

Note
Support for the 5 GHz Wi-Fi band is mandatory for use with the Delair Link module.
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2.2.2 Recommended tablets

The Delair Flight Deck software has been fully tested and optimized on the following Android tablet
models, which Delair recommends for monitoring your aircraft during flight:

• Samsung Galaxy Tab S2 (SM-T819)

• Panasonic Toughpad FZ-A2 (Android 6.0 - WWAN 4G - GPS - WLAN - 32GB SSD)

• Huawei Mediapad M5

Please note that this list may change. Check your sales representative for more information.

2.3 Delair Link communication module

As an option, you can control the aircraft using the Delair Link communication module.

2.3.1 Overview

1

2

3

N° Description

1 Antenna 2.4 GHz for aircraft communication

2 USB-C connector for battery charging(1)

3 Buttons and screen

(1) The charger is included in the standard toolkit.
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2.3.2 Buttons and screen

Buttons

1

2

4

3

5

6

7

N° Function Description

1 Power button • Long press (> 3 s) to power the device on / off

• When the device is off, press briefly to display the battery
status.

2 Abort landing
button

The button does nothing if the aircraft is not in landing phase.

If it is, then the button triggers the “Abort landing” procedure (see
Abort landing on page 62).

This is an exceptional safety procedure, to preferably be used only if
for any reason you are unable to do it with the Delair Flight Deck
tablet (for instance, the tablet ran out of battery).

3 Up button

4 Down button

Use the Up and Down buttons to switch between the main screen
(status) and the second screen (network information)

5 Confirm button -

6 Cancel button -

7 Screen display -
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Main screen

N° Description

1 Battery status

2 Distance between the station and the aircraft

3 Aircraft communication status

Second screen

This screen shows local network access information.

2.3.3 Setting menus

Screen Description

Buttons back-light brightness

Local Wi-Fi frequency (2.4 GHz or 5 GHz)(1)

Local Wi-Fi password reset (a new pass phrase is
randomly generated)

(1) By default, set to 5 GHz (recommended value).

CAUTION
Local regulations might mandate setting the communication frequency to 2.4 GHz. Announced
communication ranges and performances apply to the 5 GHz configuration.

1 Access the settings with a long press (> 2 s) on the Confirm button.

2 Use the Up and Down buttons to switch between the various settings.

3 Press the Confirm button to select the setting to be modified.

4 Press the Up and Down buttons to set the new value.

5 Validate the change with the Confirm button.

6 Press the Cancel button to exit the setting menus and return to the main screen.
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2.4 Transport bag

2.4.1 Features

• Shoulder strap (removable)

• Backpack straps with sternum strap

• TSA lock for easy travel in the US (preset on 000)

• Address tag

• Outside pocket (to fit tablet)

• Wing spacer foam (supporting foam plate)

2.4.2 Overview

The transport bag has enough storage compartments for:

1

2

3

4

5

7

8

9

5

11 

10

12

6

1 One right wing (1)

2 One left wing (2)

3 One fuselage with belly plate (3)

4 Two wing joiner tubes (4)
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5 Up to 6 propellers (5)

6 Up to 4 batteries (6)

7 One Torx T10 screwdriver (7)

8 One spare belly plate (8)

9 Three Pitot tubes (9)

10 One charger (10)

11 Delair Link (11)

12 Lens cleaning kit, cables and adapters (in different pockets)

13 Supporting foam plate (wing spacer foam) (12)

One tablet also fits in outside pocket.

2.4.3 Aircraft docking

The wing spacer foam also functions as a supporting foam plate for docking the aircraft during
assembling, pre-flight operations and disassembling.

The figure below shows the wing spacer foam placed on the transport bag.
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The figure below shows the positioning of the aircraft on the wing spacer foam.
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3 Software overview

3.1 Installation

Search for Delair Flight Deck on Google Play or scan the QR code to download the application on
your tablet.

The Delair Flight Deck application is localized and supports the following languages in addition to
English: Chinese (Mandarin), Spanish, French. The language used for the application is the one used by
the Android system (default is English).

For experienced users without access to the Google Play store, the Android package (APK) is also
available for sideloading on https://download.mydelair.com.

3.2 Configuring cellular connection on the tablet

This section only applies to configurations with cellular option enabled.

1 Install the Delair SIM card into your Android tablet.

2 Go to Settings > Connections or Networks > Mobile/Cellular Networks.

a) Enable data roaming on the Delair SIM.

b) Set Network mode/type to 3G only.

c) Tap Access Point Names (APNs) to access the list of configured APNs.

d) Tap on APN "Movistar.es" and edit it.

e) Change Name (first field) to Delair.

f) Change APN (second field) to delairtech.telefonica.com.

g) Tap the More icon (three dots, at the top right corner of the page) and then Save.

3 Back on the APN list page, select APN Delair.

4 Disable any Wi-Fi connection and enabled the Mobile/Cellular data.

The tablet should show a cellular connection if a cellular network is available in the area.

On certain Android devices, a cellular connection indicator is displayed (such as 3G, or H, H+) in
the status bar. The name of the cellular operator is usually accessible through the relevant Android
menu.
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3.3 First time configuration

• The very first time you open the application, you will be asked to grant the application
permissions on the device (to use the device’s location, to access files on the device, etc.). Tap
Allow to accept each requested permission.

• When a new aircraft is used for the first time with the tablet, the aircraft must first be
associated to the tablet, and properly configured:

1 Tap the menu  .

2 Tap   Maintenance.

3 Follow the procedure described in Association on page 17.

4 Follow the procedure described in FCC/CE Setting on page 17.

• Choose measurement system and other configuration settings at your convenience:

1 Tap the menu  .

2 Tap  Settings.

3 Follow the procedure described in Units on page 17.

3.4 The "My missions" screen

This screen list all your missions, and for each mission, all its flights. The application distinguishes two
key concepts:

• Mission:

A mission is defined by its areas of interest and possibly a few no-fly zones (areas over which
the aircraft is forbidden to fly). Areas and no-fly zones can be hand-drawn or imported from
KML files.

• Flight:

A mission may contain as many flights as you want. A flight is defined by its actual settings
(given area within a mission, wind direction, GSD, etc.) Each flight in Delair Flight Deck has a
state, which can take one of the following values:

State Description

Pending The flight is still being edited and all necessary information has not yet been
entered.

Ready The flight is fully prepared and ready to be performed. You can prepare going to
the field and launching your aircraft.

Flown After the aircraft landed, the flight is considered completed and marked as flown.
Flown flights are read-only and cannot be edited. They can be copied however as a
baseline for another similar flight.
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3.4.1 Mission preparation screens

When preparing a mission and scheduling a flight, the application will guide you through three main
steps:

1 Set the mission scope.

2 Download maps (for offline use on the field).

3 Schedule a flight.

Additionally, the following map controls can be found on the screen:

Icon   Description

Wind direction Tap and drag the arrow to indicate the wind heading.(1)

Compass Sometimes during panning or zooming the map can be
angled. Tap this button to reset the map so North is at the
top of the screen.

Target Tap this button to center your current position on the
screen.

Aircraft Tap this button to center the location of the aircraft on the
screen.(2)

(1) This control is only active during flight scheduling.

(2) This control is only visible during flight monitoring.
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3.4.2 Flight monitoring screen

The flight monitoring screen is organized as follows:

Map controlsFlight mode controls

Indicator

Status bar

Picture controls

Height

Indicators and alarms

Wind

view

(FTS)
Flight Termination System

Map

Edit
landing
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3.5 Maintenance screen

3.5.1 Association

When a new UX11 aircraft will be used for the first time with the tablet, the aircraft must first be
associated to the tablet to retrieve its identification and network configuration settings.

This information will later be used when binding the aircraft with the tablet (see Powering up on page
47) so that only this tablet can control this UX11 aircraft in flight.

1 On the home screen of the application, tap Maintenance.

2 Tap Association.

A wizard starts that will guide you through the association procedure.

3.5.2 FCC/CE Setting

Telecoms regulation standards impose restrictions on Wi-Fi frequency use, power levels, etc.

This procedure allows the user to switch the UX11 aircraft into maintenance mode and to set the
appropriate compliance setting:

• FCC

• CE.

CAUTION
This function is only to be used when a temporary radio reconfiguration is needed in order to comply with
local regulations, for instance when travelling from the USA to Europe for a survey job. Users shall comply
with local radio regulations at all times.

1 On the home screen of the application, tap Maintenance.

2 Tap FCC/CE Settings.

A wizard starts that will guide you through the procedure.

3.5.3 Firmware update

With this procedure you can update the firmware for the UX11 aircraft and the Delair Link module
(when the latter is used).

1 On the home screen of the application, tap Maintenance.

2 Tap Firmware update.

A wizard starts that will guide you through the procedure.

3.6 Settings screen

You can toggle the following settings:

Units

Here you can set the preferred units for speed, distance, altitude, and area.
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Application usage tracking

By default, the application gathers application usage statistics in background.

The collected data remains anonymous. Delair uses these global statistics only to know which features
are used and to improve user experience. For more information relating to Delair’s collection, use,
storage and disclosure of your personal information, please read our data privacy policy (as expressed
in our Privacy Statement at http://delair.aero/legal-notice-2/).

Usage tracking is very important for us to understand usage patterns and effectively improve the
product, so Delair highly recommends that you leave this option enabled.

Flight statistics

Allow Delair Flight Deck to automatically upload flight statistics to MyDelair.

Flight statistics do not contain sensitive data. Collecting and analyzing flight statistics is important for
Delair to gather information on how the aircraft is used and to effectively improve the product. Delair
recommends that you enable this option. You will be able to view your personal flight statistics on the
MyDelair platform.

Flight statistics are transferred over an encrypted connection, when Internet connectivity is available.

Flight logs

Allow Delair Flight Deck to automatically upload flight logs to MyDelair.

In order to continuously improve Delair products, and to provide the best possible experience to the
user, Delair gathers information on aircraft behavior by collecting and analyzing flight logs.

Please note that flight logs contain geolocation data (GPS coordinates and time stamps) which might
be considered as sensitive data in some countries. Local regulations may also impose restrictions on
sharing and exporting geographic information.

Delair Support or Delair-authorized third parties may access these flight logs for product improvement
analysis or troubleshooting issues that might have occurred in-flight.

Flight logs are transferred over an encrypted connection, when Internet connectivity is available

If sharing this information with Delair is possible, your enabling this option is appreciated.

Rapid climb

Enable/disable the Rapid climb button.

The Rapid climb button allows the user to let the aircraft perform a rapid climb of 30 meters (98 feet)
in order to avoid bird attacks on the aircraft.

By default, the button is disabled. We recommended to enable the Rapid climb button only when
needed, for instance when flying in areas where birds of prey are common.
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4 Specifications and limitations

4.1 Specifications

4.1.1 UX11 aircraft specifications

Aircraft

Feature Value

Endurance(1) Up to 59 min

Weight (payload included) 1.45 kg (3.2 lbs)

Wingspan 1.1 m (43 in)

Deployment time(1) 5 min

Cruise speed 54 km/h (34 mph)

takeoff / Landing Hand-launched (angle: 30 degrees) / Belly landing (angle: 30
degrees)

Flying range(1) 50 km (31 mi)

Operational surface area covered(1) • 1.2 km² (300 ac) mapped with 1.7 cm GSD at 122 m
(400 ft) AGL

• 6.5 km² (1600 ac) mapped with 14 cm GSD at 1000 m
(3,280 ft) AGL

Maximum height Delair Flight Deck limits the flight height to 1000 m above
the initial position.

GNSS receiver • PPK optional (software activated)

• L1/L2

• GPS + GLONASS

(1) With 70% side overlap. Actual results may vary depending on aircraft configuration, battery age and
condition, and operational, environmental and climate conditions.
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Operating conditions

Feature Value

Weather 45 km/h (28 mph, 24.3 kn) wind resistance

Maximum tested altitude(1) Takeoff at 5000 m (15,100 ft) / Flight at 6,000 m (19,700 ft)

Landing accuracy(1) 5 m (16 ft)

(1) Actual results may vary depending on aircraft configuration, battery age and condition, and
operational, environmental and climate conditions.

4.1.2 Sensor specifications

Built-in industrial-grade RGB camera sensor

Feature Value

Sensor type Global shutter, distortion free

Image resolution 21.4 megapixel

Dynamic range 70 dB

HFOV / VFOV 38° / 32°

In-flight sensor configuration Auto or manual

In-flight picture transmission and
quality indicators

Real-time histogram plot and photo preview

4.1.3 Data link specifications

Communication range

Feature Value

3G Unlimited (within network coverage)

Delair Link (2.4 GHz radio link)(1) • FCC: typical 5 km (3.1 mi) and up to 10 km (6.2 mi)

• CE: typical 3 km (1.8 mi) and up to 5 km (3.1 mi)

(1) Actual results may vary depending on aircraft configuration, battery age and condition, and
operational, environmental and climate conditions. For best performance, Delair Link must be placed:

• at more than 1 m from any electronic device (computer, tablet...)

• at more than 50 cm from the ground (for example, on a table).
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4.2 Limitations

4.2.1 Operation limitations

The UX11 cannot safely fly in all weather conditions. The acceptable range for different conditions is
shown below.

Note
Your country of operation may have different or additional operational requirements. Make sure you are
familiar with the appropriate regulations for the country you are operating in.

CAUTION
If a condition exceeds the stated acceptable range, you should abort the flight. Flying outside the
acceptable range of conditions will void your Delair warranty. Delair does not guarantee good picture
quality when flying in conditions beyond these limits. Local conditions required by National Airworthiness
prevail if they are more conservative than the conditions mentioned below.

Condition Acceptable range

Weather limitations Light rain for up to 5 minutes (sufficient time to
land)

Avoid hail, snow, heavy showers and icing
conditions.

Head wind (for cruise flight) Maximum 45 km/h (28 mph, 24.3 kn)

Cross wind:

• For takeoff/landing

• For cruise flight

 

• Maximum 30 km/h (19 mph, 16.2 kn)

• Maximum 45 km/h (28 mph, 24.3 kn)

Gusts (for cruise flight) Maximum 15 km/h (9 mph, 8.1 kn)

Turbulence Avoid turbulence at all times

Temperature UX11 • Pre-flight conditioned temperature: 0 °C
to +30 °C (32 °F to 86 °F)

• Approved temperature during flight: -20
°C to +40 °C (-4 °F to 104 °F)

Temperature battery(1) 0 °C to +30 °C (32 °F to 86 °F)

(1) Pre-flight conditioned temperature

4.2.2 Flight environment

Wind

Do not begin or continue a flight if the aircraft is encountering (or is going to encounter) winds in
excess of 45 km/h (28 mph, 24.3 kn) (including gusts).
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Note
The wind gradient must be taken into account when measuring the surface wind. For example, if the
measurement on the ground is 30 km/h (18.6 mph, 16.2 kn) it may be 45 km/h (28 mph, 24.3 kn) at an
altitude of 150 m.

Aerodynamic factors

The following phenomena may disrupt a flight:

• Thermals: occasionally violent updrafts, especially in higher ground (< 7.2 km/h (4.47 mph, 3.89
kn)).

• Dynamic winds: accelerations in wind due to terrain (< 7.2 km/h (4.47 mph, 3.89 kn) vertical
and < 45 km/h (28 mph, 24.3 kn) horizontal).

• Turbulence: unstable wind generated by an obstacle upwind (order of magnitude: presence of
turbulence over a distance five times the height of the obstacle).

Rain

Avoid using the aircraft in a damp environment (be careful with morning dew, for instance) or when
it is raining (see Operation limitations on page 21). If the aircraft has been flown during rainy
weather, ensure it has dried out completely before performing a new flight.

Note
The aircraft must be stored in a dry environment.

Storm

Do not begin or continue a flight in the presence of a storm (Cb) within a radius of 15 km around the
flight area.

4.2.3 Obstacle clearances

When defining a flight, you must ensure that the mission area is clear of obstacles at the flight height
and the selected takeoff and landing locations.

When you arrive at the site, visually check the takeoff and landing locations to ensure that the selected
locations are free of obstacles.

Obstacle clearances for the different stages of a flight are shown below.

Takeoff

From the takeoff location to 50 m (164 ft) in the launch direction, the area must be free of obstacles
within 30° to the left and right of the launch direction.

0 m

50 m 280 m

30 °

30 °
“

 

Delair | 676, Rue Max Planck – 31670 Toulouse-Labège, France | Tel: +33 (0) 5 82 95 44 06 | www.delair.aero
Capital: 238 110,30 € - APE: 3030Z – Intra-Community VAT number: FR90 53 09 69 781 – 530 969 781 R.C.S. Toulouse

This document is the sole property of Delair and cannot be used or reproduced without the written authorization of Delair. 22



User Manual UX11    

From 50 m (164 ft) to 280 m (919 ft) in the launch direction, no obstacles may be present above
the safety area determined by a 15° angle and within 25 m (82 ft) to the left and right of the launch
direction.

50 m 60 m

15 m

15 °

Flight

No obstacles may be present in an area of 15 m (49 ft) below the cruise flight height and connections
(between take-off/landing and flight area). The Elevation graph must be used to visualize altitude
above terrain along the complete flight plan.

cr
ui

se
 h

ei
gh

t

15 m
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Descent

When entering the landing orbit, no obstacles may be present within a 200 m (656 ft) radius of the
center of the orbit.

60 m

160 m

200 m

20°

45 m

160 m 
200 m

Once the aircraft has descended to the final height (60 m; 148 ft), the required obstacle-free area has a
height of 45 m (145 ft).

Landing

Once you confirm the landing, the aircraft starts the final leg of the landing. Along the final leg of the
landing, there must be a clear area free of obstacles within 20 m (66 ft) to the left and right of the
landing direction.

In the final leg of the landing, the obstacles must stay in the orange zone shown in the vertical cross
section of the landing. The ground should be relatively flat 40 m (131 ft) before landing for the height
sensor to correctly estimate when the aircraft should flare. In addition, the landing location must be
free of obstacles and meet the minimum size indicated:

10 m 
10 m 

10 m 
20 m

During the final leg of the landing it is possible to click the Abort button (see Abort landing on page
62).

To successfully abort the flight, extra clearances should be taken into account:
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60 m

20°

45 m

-40 m
-130 m

50 m

Abort

Abort

Abort

15°

4.3 GSD and height

The GSD (ground sample distance) specifies the distance on the ground represented by the pixel of
a captured image. It depends on the camera sensor’s pixel size and lens focal length. The smaller the
GSD value, the more detailed the images. The GSD and the height at which the aircraft flies are linked.
The higher the aircraft flies, the larger the distance on the ground represented by each pixel in the
images.

4.4 Image overlap

The percentage of image overlap allows processing software to refine for errors in the position and
orientation of the aerial images.

Delair recommends having a forward overlap of 80% and a sidewards overlap of 60% which gives the
most accurate results while minimizing flight and processing time.

An increase of the overlap may be beneficial when flying over terrain that does not have many
identifiable features in the images that can be used as tie points for the image adjustment. Examples
are dense tree canopy, bodies of water, or large areas of sand or snow.

Image overlap also varies with changing terrain elevation and features.
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5 Preparing a mission

5.1 Creating a mission

Before you begin

• The Delair Flight Deck software must be installed on the tablet.

• The tablet must be switched on and connected to the internet.

1 Tap the Delair Flight Deck icon on the tablet.

The home screen is shown.

2 Tap CREATE.

3 Enter a name for the mission.

4 Optionally, in Notes, you can enter additional information about the mission.

5 Tap CREATE.

The mission opens in the Scope tab.

5.2 Setting flight areas and no-fly zones

You can now set the scope of the mission. You can define:

• the area(s) to be surveyed (area where picture will be taken)

• (optionally) no-fly zones. These are zones that must not be overflown by the UX11 aircraft.

1 Type the name of the area where you want to survey in the search box.

The name can be a place name, a full address or latitude/longitude coordinates.

The map view jumps to the desired location.

2 Tap ADD.

3 Tap AREA.

4 Enter a name for the area.

5.2.1 Creating a polygon

1 Tap on the map to set each boundary point of the area.

2 Tap DONE.

The area of interest is calculated and shown in blue on the screen.

5.2.2 Editing a polygon

You can edit a polygon as follows:

• To resize or reshape the polygon, tap and drag boundary points on the map.

• To add a boundary point, tap the edge of the polygon.
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• To delete a boundary point, tap and drag that boundary point to one of the other boundary
points.

5.2.3 Adding no-fly zones

A no-fly zone is a virtual boundary the aircraft cannot fly through. Whatever happens, the aircraft will
stay out of the restricted airspace. The set no-fly zone is strictly respected by creating a safety buffer
(100m) that prevents the aircraft from accidentally exceeding the boundaries.

• If the aircraft comes inside the safety buffer, it will automatically try to move away from the
boundary. Once out of safety buffer, it resumes its previous navigation target. If the aircraft
stays inside the safety buffer for too long, it will eventually abort the mission and go to landing
(level 2 alarm).

• If the aircraft exceeds specified boundary it triggers the fail-safe procedure (level 4 alarm).

Figure 5-1 Creating a no-fly zone.

1 In the SCOPE tab, tap ADD.

2 Tap No-fly zone.

3 Tap on the map to set each boundary point of the no-fly zone.

4 Enter a name for the no-fly zone.

The no-fly zone is calculated and shown in red on the screen.

5 Tap DONE.
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5.3 Downloading maps, DEM, and custom DEM

5.3.1 Downloading a map and a DEM

1 Tap the MAP tab.

• A white zone shows the maps that will be downloaded.

• A warning sign indicates that the maps are not yet available offline.

2 If required, tap EDIT ZONE to modify the zone to be downloaded.

3 Tap START DOWNLOAD to get the offline DEM and map tiles.

Download can take 10 to 20 minutes for a large area.

Delair uses SRTM90 (Shuttle Radar Topography Mission) as standard DEM source.

After a successful download, the message Download successful is shown.

5.3.2 Use a custom DEM

Delair Flight Deck allows you to use your own DEM file. This feature is recommended in following
cases:

• terrain in your area has been significanty modified: mines and quarries

• your area is located above 60° latitude (not implemented in default DEM)

Supported DEM files:

• Format: GeoTiff Format

• Maximum size: 2GB and 100 000 000 pixels

• Units: meters or feet. If not indicated in the GeoTiff, meter is considered as default.

To import a custom DEM:

1 Make sure your file is located into your tablet Downloads folder

2 Tap the MAP tab

3 Tap Import DEM: a pop-up display available files. Select your file in the list and press OK. Your file
is now listed below Custom DEM and the map view is centered on its location.

Note
Once a custom DEM has been imported, it becomes available to use for flights created. For each flight
created users must specify if a custom DEM is to be used, see Managing the flight settings on page
28.

5.4 Defining the flight

5.4.1 Managing the flight settings

1 Go to the FLIGHTS tab.
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2 Tap ADD A FLIGHT.

3 Enter a name for the flight.

4 Enter a name for the pilot.

5 Verify and/or set the area settings.

• Ground Sampling Distance (GSD)

• Height. The flight height can be defined in two ways:

– using the DEM (default configuration): in that case the aircraft trajectory
(waypoints) follows the terrain elevation.

CAUTION
In the generated flight plan, waypoints are located at the end of flight lines (where the aircraft
turns) and set above terrain elevation. Between waypoints aircraft always follow a straight
line. If there is a steep hill between 2 waypoints, the aircraft will not follow terrain of that hill.
Elevation graph allows you to check your flight height. A warning is displayed if there is a risk
to hit terrain. If terrain is very hilly please consider flying above aircraft's initial position (see
below), it may be easier to ensure a minimal flight height.

– fixed above the aircraft's initial position (if the option is manually selected by the
user): in that case the aircraft will fly at a fixed altitude above the aircraft's initial
(start-up) position

Note
Clicking on the SHOW ELEVATION on the map button allows to visualise the aircraft height
above ground if DEM is available.

CAUTION
Because the aircraft initial position is unknown at the time of flight preparation, the elevation
graph uses the pre-defined takeoff location. It is strongly recommended to switch on your
aircraft close to the takeoff location otherwise the elevation graph may be significantly wrong.
If that cannot be done, the user should update takeoff location and verify the elevation graph
(clicking on the SHOW ELEVATION button).

• DEM: If a custom DEM has been imported on the tablet, a dropdown list allows you to
select the DEM to use for the configured flight.

Note
The complete flight shall be included in the custom DEM boundary.

• Forward overlap: based on the configured overlap, the system will keep the forward
overlap constant throughout the flight taking into account flight height and ground speed
(which ensures constant overlap even in varying wind conditions for instance).

• Side overlap

• Margin (distance to be flown outside the area, computed automatically)

• Optionally, toggle the Flight lines direction linked to wind option.
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Note
It is recommended to leave this option checked.

Note
If area cannot be completed in a single flight, the software estimate a termination point for the
flight. Flight lines that cannot be achieved are grayed out. Landing is automatically connected
to termination point. Each time flight plan is modified termination point is updated. Moving
take-off and landing may increase flight time and change termination point. Uncovered area
may be completed by resuming flight plan, see Managing the flight settings on page 28

5.4.2 Set the takeoff location

1 Tap on the map to add a takeoff location.

The takeoff location and some waypoints indicating the route of the UX11 from the takeoff point
to the start of the area flight path are shown.

2 Verify that a couple of waypoints have been created automatically. You can move them by
touching and dragging the waypoints so that the trajectory entering the flight plan is acceptable.

3 To reposition the takeoff spot, tap and move it on the map.

4 Tap DONE or Next.

5.4.3 Set the landing location

The landing location can be set beforehand. You can also set the landing location just before the flight,
see Finishing the creation of the flight plan on page 43.

Note

The landing position must be selected in a way that the ground is relatively flat 40 m (131 ft) before
landing and that the landing area is suited for landing (no obstacles or inappropriate surface), see Obstacle
clearances on page 22.

1 Tap on the map to add a landing location or move to desired location and press Here button
(tablet GPS must be enabled).

The landing location and some waypoints indicating the route of the UX11 from the end of the
area flight path to the landing location are shown.

2 To edit the landing route, tap and drag the waypoints on the map.

3 To reposition the landing spot, tap and move it on the map.

Note

It may be necessary to use an altitude offset if the landing position differs from the aircraft power up
position. See section Completing the pre-flight checklist on page 47.

4 Select Heading linked to wind.

5 Select the direction of the entry circle:
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• Right (default)

• Left

6 Tap DONE.

5.4.4 Setting a geofence

A geofence is a virtual boundary the aircraft cannot fly through. Whatever happens, the aircraft will
stay within a restricted airspace. It can be horizontal (a circle or a polygon) and/or vertical (a ceiling).
The set geofence is strictly respected by creating a safety buffer (100m horizontally and 20m vertically)
that prevents the aircraft from accidentally exceeding the boundaries.

• If the aircraft comes inside the safety buffer, it will automatically try to move away from the
boundary. Once out of safety buffer, it resumes its previous navigation target.

• If the aircraft stays inside the safety buffer for too long, it will eventually abort the mission and
go to landing (level 2 alarm).

• If the aircraft exceed specified boundary it triggers the fail-safe procedure (level 4 alarm).

• It is not possible to execute a flight plan that goes into the safety buffer or exceed boundary.

Example: if you set the flight height to 122m then you have to set the geofence ceiling at least
20m above, i.e. 142m. You will not be able to plan and execute a flight plan that goes above 122m.
Whatever happens, during flight aircraft will automatically avoid going higher. If, because of strong
weather or any failure, aircraft goes above 142m it will trigger the FTS.

Geofence ceiling is set above aircraft initialization point while flight plan is set above terrain.
Depending on terrain, flight height may be higher than ceiling even if using the same value. Elevation
graph allows you to check that your flight plan is lower than your ceiling (including the safety buffer),
See Viewing the flight plan elevation on page 33.

Figure 5-2 Setting a geofence (circle).
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Figure 5-3 Setting a geofence (polygon).

The geofence feature is disabled by default.

1 Tap Geofence settings.

2 Select Enable.

3 Choose the form of the geofence:

• Circle (default). Set the radius.

• Polygon. Tap the map to set the boundary points.

4 Set the height of the geofence.

5 Tap the back arrow to return to the Flight details screen.

5.4.5 Checking the communication timeout

The communication timeout value defines when the aircraft should activate the emergency pattern in
case of loss of the communication link.

Enter a value in the communication timeout field between 5 seconds and 150 minutes (2h30). The
default value is 30 seconds.
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5.5 Viewing the flight plan elevation

To ensure that the aircraft stays within its safe capabilities, tap SHOW ELEVATION to view the elevation
profile.

A graph is displayed that shows the ground elevation, flight height and, if set, the geofence height.

The SHOW ELEVATION button turns red when there are issues with the flight height. For example
when the flight is set too low or if the slope of the ground is steeper than the rate of climb of the
aircraft.

When the SHOW ELEVATION button is red the user must Tap on it to analyse the reason for the
warning. The following elevation graph is shown:

In case of long flight plans (requiring more than one flight), it is possible to check the elevation profile
of the subsequent flights (after the current flight) by tapping the FULL FLIGHT PLAN tab. This allows
you to anticipate issues that may appears on subsequent flights when resuming flight plan.
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5.6 Resume uncompleted flight

If, for any reason, the aircraft landed before the mission area is fully covered, it is possible to easily
prepare another flight to complete the area.

Once landed, in the post-flight checklist the following message is displayed and it allows to create a
flight:

By clicking on the « Create flight » button, a new flight is created. Its caracteristics are identical to the
original flight:

• Geofence

• Takeoff

• Landing

The area is reduced to the uncovered part (see figure below in blue). The already covered part is
shown in green and not planned in the mission.

An uncompleted flight can also be continued from the flight list. To do so, open the flight menu and
select Continue as depicted below. The continuation flight is created.
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6 Flight scheduling

6.1 Check flight conditions and permissions

In the days before the flight, complete the following checks to make sure the flight can proceed.

Note
The use of unmanned aircraft in any national airspace system is regulated by the applicable National
Aviation Authority. The regulations for flying unmanned aircraft are subject to change. It is the user’s
responsibility to know and adhere to the current laws for operating in the national airspace system. Delair
is not obliged to inform users of changes to unmanned aircraft laws. Delair and Authorized Distribution
Partners provide comprehensive training for the unmanned aircraft system which includes recommended
procedures to ensure the safety for the remote crew members as well as the surrounding environment. It
is the user’s responsibility to ensure safe operations and adhere to safety and security measures required
by the National Aviation Authority. Delair is not responsible for ensuring safe and secure operation of
unmanned aircraft by the user.

6.1.1 Check the flight permission

• Check if you need a permit to operate an unmanned aircraft in the airspace above the site.

• Make sure you understand the legal context for safe operation of an unmanned aircraft.

• Check for existing rules and standards with your local Civil Aviation Authorities (CAA).

• Make sure you have permission from the landowner.

• Make sure you have all other relevant permissions required for photography flights using
unmanned aircraft. In some countries you need permission from defense organizations, the
police, or a national geography institute to take pictures.

6.1.2 Check the weather

• In the days before the flight, check the TV weather broadcast or weather websites. This gives
you a good general idea of the weather for the next three to four days.

• For more accurate weather forecasts, consult and interpret aviation weather data through
various weather websites. You can also contact the national meteorological office or a local
meteorology office at an airport nearby.

• On the day of the flight, consult the Terminal Aerodrome Forecast (TAF) and METAR reports.
These are local meteorological reports used in aviation.

• Make sure the weather conditions are within the operating limitations. See Operation
limitations on page 21.
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6.2 Check the site

Note
When checking the site you should refer to the relevant AIP (Aeronautical Information Publication) and
NOTAM (Notice to Airmen) documents for your region.

• Identify the airspace and geographic environment of the site.

• Check the relevant aviation charts and make sure the flight area is not near any of the following
areas:

– Forbidden airspace

– Airports and airfields (except with prior permission)

– Power plants (except with prior permission)

• Take special care around the following areas:

– Parachute jumping and parasailing areas

– Winch areas

– High-pressure gas-releasing units (documented in AIPs or NOTAMs)

– Congested areas (for example, towns)

• Check if other aerial or ground activities are planned at or near the site, for example major
public events.

Note
This list is not exhaustive. It is the responsibility of the user to be aware of any local conflicts that may result
in a hazardous situation.
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7 Preparing the equipment

7.1 Checking the UX11

1 Verify that the UX11 is complete:

• one right wing

• one left wing

• one connecting rod

• one belly plate

• one fuselage

• one Pitot tube

• one battery

• additional batteries and spare parts as needed, depending on the scope and size of the
project.

2 Perform a general inspection of the parts to identify any flaws or mechanical problems that need
attention. Address any issues.

3 Verify the lens of the camera. If required, clean it with the lens cleaning kit.

4 Verify that the two batteries are fully charged. If not, charge the batteries.

7.2 Charging the UX11 battery pack

Use the UX11 charging system to charge and discharge a UX11 battery pack. The charger also includes
an automatic charge-discharge function to recondition your battery when needed.

The flowchart below gives an overview of the different operations.
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7.2.1 Charging cable

A specific cable (part number FDG-000071) is required to safely charge the battery pack.

Connect the cable as follows:

1 Connect the charging cable bananas wires to the charger.

2 Connect the charging cable balancer wire to the charger.

3 Connect the balancer battery cable to the charging cable receptacle.

Note
The battery power wires are not used for charging.

7.2.2 Charger settings

The charger only has a safety timer setting and a buzzer setting to adjust.

Setting the safety timer

This setting sets the time limit after which the charger will stop the charge/discharge/cycle process.
You can increase or decrease this setting during the start-up procedure of the charger just after you
have plugged in the power cable. Good settings are:

• 180 min for normal charging or discharging of batteries.

• 65 min for cycle mode.

In this case the charger will end its cycle after 65 min. See Cycle mode on page 41 for more
information on the cycle mode.

Setting the buzzer

This setting sets the buzzer sound (on or off). You can modify this setting during the start-up
procedure of the charger, just after you have plugged in the power cable.

7.2.3 Charging and discharging mode

In this mode you can select the battery type (UX11) and the charge state (30%, 50% or 100%).

• 30%: Use this setting for transporting your batteries by plane if required.

• 50%: Use this setting for (longer term) storage of the battery.

• 100%: Fully charged battery.

1 Press the PROG/MODE button until you see a screen similar to the one below:
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2 Press the ENTER/START button until you see 100%, 50% or 30% blinking.

3 Press the DEC/INC buttons to select the desired charge state.

4 Press and hold the ENTER/START button to start the process.

7.2.4 Cycle mode

In this mode you can recondition a battery by putting it through multiple charge-discharge cycles.

By cycling the batteries, the individual cell voltages are balanced.

1 Press the PROG/MODE button until you see a screen similar to the one below:

2 Press the ENTER/START button until you see UX11 blinking.

3 Press the ENTER/START button until the number next to C->D starts flashing.

4 Use the DEC/INC buttons to select the desired number of cycles.

5 Press and hold the ENTER/START button to start the process.

RESULTS

The cycle process will always start and end with a charge.

For example, when selecting 3 cycles, the sequence will be:

Charge - Discharge - Charge - Discharge - Charge - Discharge - Charge

When setting the safety timer to 65 min, the total maximum time spent for completing the 3 cycles
will be 7 × 65 min = 455 min.

7.2.5 Checking battery parameters while charging

During charging/discharging or cycling you can check the battery’s parameters.

1 Press and hold the DEC and INC buttons simultaneously.

2 Use the INC or DEC button to cycle through the parameters

RESULTS

The most important parameter is the individual cell voltages (see below).

You can also view the maximum unbalancing difference (last screen).
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Delair strongly recommends that the maximum unbalancing difference is lower than 0.020 V.

If the maximum unbalancing difference is higher than 0.020 V after normal charging, then please
recondition the battery by putting it through multiple charge-discharge cycles (see Cycle mode on
page 41).

7.2.6 Checking battery level with the LiPo checker

A LiPo checker (battery cell checker) is provided with the charger. It can be used to verify battery (and
individual cell) charge level.

A charging cable is required to connect battery to LiPo checker (provided in transport bag):

1 Connect the charging cable balancer wire to the LiPo checker.

2 Connect the balancer battery cable to the charging cable receptacle.

3 Read individual cell voltage on the LiPo checker. When battery is fully charged, each cell voltage is
4.2V.

7.3 Charging the Delair Link communication module

Plug the supplied charger into Delair Link’s USB-C connector.

The charge progress indicator is displayed on the screen.

CAUTION
Use only the charger supplied with Delair Link (included in the standard toolkit). Do not use any other non-
approved charger.

7.4 Checking the tablet

Before leaving for the flight location, make sure that:

• the tablet is fully charged.

• the sound volume on the tablet is turned fully up.

7.5 Storing your equipment in the transport bag

Store the equipment in the transport bag:

• All the parts of the UX11

• Two batteries (up to four batteries can be carried in the transport bag)

• Tablet

• Delair Link and its USB charger (when applicable)

• License and insurance documents (optional, depending on local regulations)
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8 Executing a flight

8.1 Checking the environment

1 On the day of the flight, check the following at the flight location:

a) Check the field for obstacles that could be a problem for takeoff or landing.

b) Observe the current weather conditions, particularly the wind direction and wind speed.

c) Evaluate the nature of the terrain (grass, sand, cement, rocky terrain, soft terrain, slopes…).

d) Verify whether people are present in the area of the flight.

2 Decide whether the terrain is fit for safe takeoff, operation and landing.

8.2 Finishing the creation of the flight plan

In this procedure, some final settings are made which can only be done at the location of the flight.

1 Tap and drag the wind arrow to set the wind direction.

The flight plan is automatically rotated to stay perpendicular to the wind.

2 Tap Landing strip and adjust settings if required, then tap DONE.

3 Adjust waypoints by touching and dragging so that the trajectory entering and exiting the flight
plan is acceptable.

4 Check one last time that the parameters of the flight (duration, altitude, overlap) are correct
(reasonable area, reasonable flight time and number of pictures).

5 Tap START CHECKLIST.

Note

This button is not enabled if:

• the duration of the flight plan is longer than 59 minutes.

• the flight plan intersects a no-fly zone or is partially outside the geofence area.
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8.3 Assembling the UX11 aircraft

CAUTION
When handling the fuselage, do not hold it by motor housing (orange plastic part covering the motor).

1 Take the wings, the fuselage, the connecting rod and the supporting foam plate out of the
transport bag.

2 Place the supporting foam plate on the transport bag.

3 Place the fuselage on top of the supporting foam plate (with the Pitot tube location facing up).

4 Take a Pitot tube out of the transport bag.

5 Blow in the static pressure port hole and in the dynamic total pressure port hole to make sure
they are not clogged.

6 Attach the Pitot tube on the double barbs on top of the fuselage.

7 Place the connecting rod in the fuselage and center it.

 

Delair | 676, Rue Max Planck – 31670 Toulouse-Labège, France | Tel: +33 (0) 5 82 95 44 06 | www.delair.aero
Capital: 238 110,30 € - APE: 3030Z – Intra-Community VAT number: FR90 53 09 69 781 – 530 969 781 R.C.S. Toulouse

This document is the sole property of Delair and cannot be used or reproduced without the written authorization of Delair. 44



User Manual UX11    

8 Slide the wings over the connecting rod till they snap into place (click sound).

8.4 Inserting the battery into the UX11 aircraft
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1 Put the UX11 aircraft upside down in a horizontal position on the supporting foam plate.

2 Remove the belly plate.

3 Place the battery in the battery compartment.

4 Connect the battery: first plug in the power cable, then the balance cable.

5 Make sure the connectors are arranged side by side and are not placed on top of each other (see
figure) and close the retaining strap.

NOTICE
Failing to do so can prevent the belly plate from closing properly. This can lead to loss of the belly
plate in flight.

6 Reposition the belly plate.

7 Turn the aircraft topside up on the supporting foam plate.

RESULTS

The Power LED on the UX11 aircraft lights up red. Tap Next on the tablet.
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8.5 Powering up

Note
Before executing this task, make sure that the aircraft is in clear view of GNSS satellites (outdoor, not close
to a tall building) and not close to metal objects (such as vehicles).

1 Press the Power button on the UX11 aircraft for 3 s.

The Power LED blinks green and the UX11 starts booting. The boot sequence is finished when the
Power LED is solid green and the Binding LED starts blinking slowly.

2 In the Communication screen, select the communication link (either 3G or Wi-Fi with Delair
Link). To Use Wi-Fi, enable Wi-Fi on the Android Tablet and connect to the correct Delair Link
Wi-Fi network. Wi-Fi information (SSID, password) of the Delair Link is available from the screen
display.

Note
If more than one aircraft is associated with the tablet, you have to select the correct aircraft from the
displayed list.

3 Tap Bind on the tablet.

The Binding LED starts blinking fast.

4 Press the Confirm button on the UX11 aircraft to validate the binding process.

The binding process is complete when the Binding LED glows solid green and the tablet displays
the message Binding successful.

8.6 Completing the pre-flight checklist

1 Keep the aircraft steady on the supporting foam plate and tap Next.

The Checklist LED on the aircraft starts blinking. The aircraft performs several auto checks
(distance sensor, GNSS, battery, system status, storage space, compass…). When successful:

• the Checklist LED still blinks green

• the tablet shows the message Auto-check OK with some detailed results and aircraft
information (firmware version, etc.).

2 Tap Next to go to the Upload flight plan screen.

3 Adjust the Landing Strip:

Positionning the landing

• Tap on the modify pencil icon (top right of the map) to open the Landing Strip menu.

• Make sure your Landing pattern is free of obstacles and adjust if required.

• Adjust the position of the Landing Strip using the Here button (position of the Tablet
used) or the Aircraft button (position of the aircraft used). For best landing accuracy, it
is strongly recommended to use aircraft location (tapping the Aircraft button) whenever
possible.

Setting an altitude offset for the landing
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• To set the altitude offset (see note below) for the landing, Choose an altitude offset either
manually or using the DEM.

• Once done, close the menu and make sure to upload the flight plan again (changes are
only taken into account when flight plan is sent again).

Note

By default, the system reference altitude is set to the altitude of the point where the aircraft is
powered up (which is not the Delair Link altitude or takeoff altitude).

Should the landing altitude differ from the reference altitude (for instance when the landing point
is far from the aircraft power up point), an altitude offset must be defined by the user. The altitude
offset can be set either manually by the operator or automatically based on a digital elevation model
(DEM).

WARNING: The applied altitude offset must be accurate (within 5 m from reality). Any inaccurate offset
manually entered might cause a failed landing.

There is no maximum altitude offset. In case of doubt, please choose an alternate landing zone, with
little or no offset.

4 Tap Upload to upload the flight plan to the aircraft.

A progress bar shows the progress of the data transfer (takes less than 30 s). When the data
transfer is finished, the tablet displays Next.

5 Tap Next.

The tablet displays Final checks.

6 Stand up and hold the aircraft horizontally at approximately 1.5 m above the ground. Make sure
the height sensor is unobstructed.

7 To trigger the Pitot test, place your thumb on the air intake of the Pitot tube in order to increase
the air pressure inside the tube. When sufficient air pressure is detected inside the tube, the
elevons start moving.

When the Pitot tube test is successful the tablet displays a green check mark.

8 The elevons move up and down in an auto test. Make sure the movement is smooth and
unobstructed.

9 Once elevons are back in position, verify that each elevon is properly aligned with its wing. If the
elevons is not well aligned, tap the Trim button

When all auto checks are successfully completed, the Checklist LED glows solid green.

Tap Next to prepare for takeoff.

In cases where the Checklist LED does not glows solid green, a failure reason is displayed on the
tablet.

8.7 Launching the UX11 aircraft

1 The TAKE OFF LED is blinking green slowly. Proceed to the takeoff location.
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2 At the takeoff location, hold the aircraft by the right wing with your right hand (or hold the aircraft
by the left wing with your left hand).

CAUTION
Make sure the propeller is clear from objects or body parts at all times during the takeoff procedure.

3 Press the Confirm button on the aircraft for a few seconds until the motor beeps.

The motor is initialized, propellers stay still, TAKE OFF LED is blinking green rapidly.

Note
As a safety measure, if you do not proceed to next step in 15 seconds, the motor will automatically
deactivate. You can also manually deactivate the motor by using the ABORT button on Delair Flight
Deck. If the motor was deactivated (automatically or manually) it may be initialized again as per text
above.

4 Hold the aircraft horizontally and against the wind, and make sure your take-off direction is free
of obstacles (adjust if necessary). Then press the Confirm button again (short push). The elevons
move up indicating the aircraft is ready for takeoff. The TAKE OFF LED is steady green (if elevons
does not move or TAKE OFF LED is blinking red, please contact support).

Tilt the aircraft with its nose up at an upwards angle of 30°. After 1.5 seconds, the motor runs at
full speed.

Note
To abort the takeoff and stop the motor, hold the aircraft vertically with its nose pointing upwards for
1 second or press the Confirm button. If takeoff was aborted you may resume and re-initiate takeoff
without starting over the entire procedure.

5 Throw the aircraft in a forward and upward motion.

Note
Avoid to give the aircraft a rotating motion while throwing.

The UX11 aircraft takes off.
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8.8 Monitoring and controlling the UX11 aircraft during flight

After takeoff, the aircraft follows its waypoints and automatically triggers the camera when necessary.

8.8.1 Monitoring

Map View

The tablet shows the map view with the programmed flight plans and displays the position of the
aircraft and its flight parameters in real-time:

• Strength of communication signal

• Battery level of the UX11 aircraft

• Elapsed and remaining flight time

• Distance between the aircraft and the tablet (in the case of a 3G link) or the Delair Link module

• Airspeed

• Height

• Number of pictures taken

Note
The battery level estimation is less accurate when the battery used is not initially fully charged (which is not
recommended).

The coverage shown on the map expands as pictures are taken. You can tap the picture control button
to view a low resolution version of the pictures, histograms and image quality indicators.

Switch Between Communication Links

This section applies to UX11 users who own a Delair Link only.

UX11 users with a Delair Link can benefit from two communication links to the aircraft: the direct 2.4
GHz radio link through Delair Link and the cellular (3G) link.

Best practices to get the best of the dual link feature are provided hereafter:

• The direct radio link (2.4 GHz) should be used for takeoff and landing phases.

• Switching between communication links (radiolink or cellular) is possible at any time during
the flight by clicking on the communication icon (top left of the application): select "Wi-Fi"
for connection to the aircraft through Delair Link, or select "3G" for connection to the aircraft
through the cellular network.
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• It is recommended to have the Wi-Fi setting (of the Android Tablet) configured to reconnect
automatically to the Wi-Fi network of the Delair Link.

Camera Settings Adjustment and photo previews

By default the UX11 camera operates in Smart Sensor mode. In this mode the camera automatically
ajusts to light conditions and chooses optimized settings.

For advanced users, it is possible to turn off Smart Sensor mode and to configure manually ISO and
shutter speed. Tap on the Camera icon (top right of the application), tap on the Setting tab, and then
turn off Smart Sensor mode as depicted below.

Thanks to the advanced onboard processing on the UX11, live photo previews can be viewed by the
user during flight. Tap the Camera icon (top right of the application) and then tap on Preview tab to
view the sample of each picture.
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8.8.2 Controlling

8.8.2.1 User-initiated flight modes

The aircraft can be controlled using the following user-initiated flight modes.

Home

The aircraft navigates through its waypoints in the direction of takeoff location. From the closest
waypoint the aircraft navigates in a straight line to the takeoff location.

• If current altitude is lower than 60m (197ft) above takeoff location, the aircraft climbs up to
60m (197ft) above takeoff location

• If current altitude is higher than 60m (197ft) above takeoff location, the aircraft keeps its
altitude to takeoff location and starts descending in circle until reaching 60 m (197 ft).

Figure 8-1 Home mode in action on the tablet.

In case of mission abort (triggered by an Alarm 2, see section on alarms below), the aircraft finds an
optimized route to go back to the landing area (often crossing through the flight plan). When the
remaining distance to landing is less than 400 m, the aircraft goes straight to land. In such cases (of
mission abort), the user must double check that there are no obstacles in the vicinity. If necessary, it is
possible to use the GoTo mode to avoid any obstacles. It is highly recommended to set no-fly zones
around high obstacles in flight area.
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Hold

The aircraft starts a waiting pattern at the current aircraft position and heading.

Figure 8-2 Hold mode in action on the tablet.

Land

The aircraft navigates through its waypoints to the landing circle. Descent starts from the last waypoint
to the landing circle, from defined flight height to 60 m (197 ft) above landing. Elevation graph can be
used to visualize altitude above terrain along the descent. If slope is too steep, aircraft follow as much
as possible the slope then finish the descent while turning on landing circle. (see Landing the UX11
aircraft on page 61).

Figure 8-3 Landing mode – aircraft navigating through its waypoints to the landing point.
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Goto

The aircraft goes to the tapped position on the map, following the heading to the target. It then
automatically switches to the hold mode, starting a waiting pattern.

Figure 8-4 Goto mode in action on the tablet.

Mission

The aircraft performs the configured mission. If you switch to another mode, you can switch back to
the mission mode.

Figure 8-5 Mission mode in action on the tablet.
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FTS (Flight Termination System)

Emergency pattern. When tapped twice, the aircraft will return to the ground in an emergency
pattern. The emergency pattern is a controlled stall: the aircraft performs a controlled vertical descent
maintaining low roll/pitch angles all throughout (aircraft stays horizontal).

Figure 8-6 Manual triggering of the FTS on the tablet.

Rapid climb

When the Rapid climb button is enabled (see Rapid climb on page 18), a button is be visible during
flight. It allows the user to let the aircraft perform a rapid climb of 30 meters (98 feet). Following the
climb, the aircraft will hold while waiting for new instructions.

This command can be used to evade a collision with a bird of prey and is intended for operations
within visual line of sight.

Keep in mind that geofence heights will always be respected so this action will not allow the aircraft
to pass the height restriction. This point should be considerd by the pilot during mission planning as a
vertical geofence cannot be adjusted after takeoff.

It is recommended to enable the Rapid climb button only when needed, for instance in areas where
birds of prey are common.

Abort landing

The aircraft goes around (see Abort landing on page 62 for details).
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Figure 8-7 Landing mode — final approach and abort landing button.
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8.8.2.2 Autopilot-initiated flight modes

The aircraft can also be in one of the following autopilot-initiated flight modes:

Takeoff

During takeoff, the aircraft climbs up to 60 m (197 ft) in a straight line, then automatically starts its
mission, or starts a waiting pattern.

Figure 8-8 Takeoff mode on the tablet.

Exclusion

The aircraft automatically switches to this mode when close to a geofence boundary (see Setting a
geofence on page 31), or a no-fly zone boundary (see Adding no-fly zones on page 27).

Figure 8-9 Exclusion mode in action on the tablet.
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Stall recovery

The aircraft automatically switches to this mode if it detects an abnormal roll or pitch angle. It switches
to simpler control laws to recover.

Landing (Alarm 2)

The aircraft automatically switches to the Land flight mode, see below.

Figure 8-10 Land mode triggered by a level 2 alarm (here, battery low alarm).

Spiral (Alarm 3)

In case of a level 3 alarm, the motor is shut down and the aircraft starts to return to the ground via
a controlled spiral procedure. The control laws compensate wind drift. Example of alarm 3 is given
below.

Figure 8-11 Spiral mode triggerred by a level 3 alarm (here, critical battery level).
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Fail-safe (Alarm 4)

In case of a level 4 alarm, the aircraft performs a controlled vertical descent maintaining low roll/pitch
angles all throughout (aircraft stays horizontal). Example of alarm 4 is given below.

Figure 8-12 Fail-safe mode triggerred by a level 4 alarm (here, geofence breached).

8.8.2.3 Waiting pattern definition

When tapping the HOLD button, the aircraft will perform the following waiting pattern until instructed
a mode change:

240 m

140 m
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8.8.2.4 Alarms

Generally, an alarm is triggered when a status or measurement indicator remains lit for a certain length
of time.

Alarms are classified into 4 levels, depending on how critical the situation is.

These alarm levels determine how the on-board system failures are managed.

Depending on the level of alarm, the system will automatically adopt an appropriate behavior and
trajectory to respond to the situation.

Alarm
level

Description This alarm is mainly triggered by:

1 A minor anomaly
(temporary
measurement error)
or altitude correction
has been detected.

The mission is not
interrupted. The
aircraft remains on its
flight plan trajectory.

• Short GNSS loss.

• Short accelerometer, gyrometer or magnetometer loss.

• Short communication loss.

• Geofence boundary too close.

• Low aircraft battery level.

2 The mission is
aborted. The aircraft
automatically
switches to the Land
mode.

• Long accelerometer, gyrometer or magnetometer loss.

• Long communication loss.

• Long Pitot sensor loss.

• Longer GNSS loss.

• Very low aircraft battery level.

3 The mission is
aborted. The aircraft
cannot go back to its
landing location but
it can still navigate.

The motor is shut
down and the aircraft

• Motor loss.

• Critical aircraft battery level.
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Alarm
level

Description This alarm is mainly triggered by:

starts to return to the
ground in safety via
a spiral procedure.
The control laws
compensate wind
drift.

4 The mission is
aborted. The aircraft
cannot navigate.

The motor is shut
down and the aircraft
attempts returning
to the ground in
safety (stall fail-safe
procedure).

• Very long GNSS loss.

Note
In this case, the aircraft is unable to monitor whether it
gets out of its geofence or not.

• High vertical speed.

• Geofence breach.

Battery level alarms:

• Alarm 1: aircraft battery level is less than 14.8V for 25 seconds - approximately 20%

• Alarm 2: aircraft battery level is less than 14.6V for 25 seconds - approximately 8%

• Alarm 3: aircraft battery level is less than 13.2V for 25 seconds approximately 0%

Communication alarms:

• Alarm 1: no communication with the aircraft for 5 seconds

• Alarm 2: no communication with the aircraft for 30 seconds (parameter modifiable by the user)

8.9 Landing the UX11 aircraft

Towards the end of the flight plan, the aircraft navigates through its waypoints to the landing location
and circles there, so as to reach a height of 60 m (197 ft) above the landing point.

The tablet shows READY FOR LANDING and a LAND NOW button.

1 Tap LAND NOW.

• The aircraft flies on its descent slope, reducing its speed using reverse thrust and elevons.
The tablet shows a large ABORT LANDING.

• The aircraft automatically flares when reaching a few meters above the ground (depending
on wind and ground speed) to land as smoothly as possible. It then touches the ground
and stops.
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• During the landing, all the LEDs are blinking red.

• Once the landing is completed, all the LEDs on the aircraft are solid green, except the TAKE
OFF LED which is off.

CAUTION
You can safely pick up the aircraft when the LEDs are solid green (except the TAKE OFF LED
which is off), not before.

2 The aircraft automatically detects the landing and notifies the Delair Flight Deck application. The
tablet then shows the post-flight checklist.

8.9.1 Abort landing

When something unexpected occurs during the landing phase before flaring, you can abort the
landing as demonstrated below (abort landing is possible down to an altitude of 15 m above the
predefined landing position).

1 Tap ABORT LANDING on the tablet.

The aircraft will climb again exactly as when it takes off.

The tablet shows again READY FOR LANDING and the LAND NOW button.

2 If required, adjust the landing location (landing spot, heading, direction of entry).

3 Tap LAND NOW when ready to retry the landing.

8.10 Completing the post-flight checklist

The aircraft automatically detects the landing and notifies the Delair Flight Deck application.

The application shows the post-flight checklist screen.

Carefully follow the instructions.

As part of the final steps in these instructions, you will notably be told to:

• switch off the aircraft with a long press on the Power button.

• switch off your Delair Link (when applicable).

• remove the battery (see Removing the battery from the UX11 aircraft on page 62).

• disassemble the aircraft (see Disassembling the UX11 aircraft on page 63).

Once the post-flight checklist is completed, the Delair Flight Deck application shows a flight
summary report, including several flight quality indicators.

This report can be displayed later at any moment from flight details.

8.11 Removing the battery from the UX11 aircraft

1 Put the UX11 aircraft upside down in a horizontal position on the supporting foam plate.

2 Remove the belly plate.

3 Disconnect and remove the battery: first unplug the balance cable, then the power cable.
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4 Place the battery in the transport bag.

8.12 Disassembling the UX11 aircraft

1 Pull the right wing away from the fuselage.

2 Place the right wing in the transport bag.

3 Pull the left wing away from the fuselage.

4 Place the left wing temporarily in a safe place to protect it from dirt or damage.

5 Remove the Pitot tube and place it in the transport bag.

6 Put the belly plate back on the fuselage.

7 Remove the connecting rod from the fuselage and place it in the bag.

8 Put the supporting foam plate on top of the right wing in the transport bag.

9 Put the fuselage in the transport bag.

10 Place the left wing in the transport bag.

 

Delair | 676, Rue Max Planck – 31670 Toulouse-Labège, France | Tel: +33 (0) 5 82 95 44 06 | www.delair.aero
Capital: 238 110,30 € - APE: 3030Z – Intra-Community VAT number: FR90 53 09 69 781 – 530 969 781 R.C.S. Toulouse

This document is the sole property of Delair and cannot be used or reproduced without the written authorization of Delair. 63



User Manual UX11    

9 Analysing, exporting and processing

9.1 Pre-processing using Delair After Flight application

9.1.1 The Delair After Flight application

Delair After Flight for the Windows 10 platform is an intuitive desktop application to import, qualify,
adjust and export your Delair UX11 data. As each image is georeferenced during its acquisition, it can
be displayed geographically in Delair After Flight. The software also enables the user to convert and
sort the thousands of images acquired during a flight according to different parameters.

Features include importing flight folders from an aircraft, applying filters to the data, viewing and
selecting images, and exporting the selected images and metadata to various formats and 3rd party
tools. It also enables PPK (Post-Processing Kinematics) baseline processing and filtering of high
accuracy data.

Supported input formats:

• Delair flight folders

• Base station files (RINEX format), for PPK processing (commercial option)

• Geographical criteria (in KML, GeoJSON or ESRI shapefile format) for filtering

Supported filters:

• Height

• Attitude (roll, pitch, yaw)

• Geographical criteria (hand-drawn geometries, or imported from KML, GeoJSON or shapefiles)

• Image indexes (numbers or ranges)

• PPK position correction type (for PPK-enabled systems)

Quality checks:

• Coverage indicator

• PPK correction type (for PPK-enabled systems)

Exported data:

• Images in JPEG or TIFF, with Exif/XMP metadata

• PDF report for exported data and selected images

• Metadata in CSV format for compatibility with other 3rd party software

• Inpho project file, for easy import into Trimble/Inpho UASMaster software

• Trimble JobXML file format (JXL), for easy import into Trimble Business Center (TBC) Aerial
Photogrammetry Module (APM)
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9.1.1.1 Installing the application

Prerequisite:

• Windows 10, 64-bit desktop computer

• Minimum requirements:

– Any CPU

– RAM: 4 GB

– Storage: HDD, 30 GB free space (approx. 2000 images in JPEG 100% quality)

• Recommended requirements:

– Quad-core Intel CPU

– GPU: Intel HD Graphics

– Storage: HDD, 30 GB free space (approx. 2000 images in JPEG 100% quality)

• The computer must be connected to the Internet during the installation process.

Procedure:

1 Go to https://download.mydelair.com.

2 Download the Delair After Flight installer delairafterflight-windows-x86_64-version.exe (where
version stands for the latest available version).

3 Launch the installer and follow the instructions.

4 During the installation, you will also be proposed to download Digital Elevation Model (DEM) files
locally. Select a subset of the DEM according to your needs.

CAUTION

To ensure that Delair After Flight works properly when computing image projections and performing
quality checks, the Digital Elevation Model (DEM) must be available for the geographical areas of
interest. It is therefore strongly recommended to install the DEM. See Digital Elevation Model on page
70 for more details.
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9.1.1.2 Obtaining PPK licenses

For high accuracy photogrammetry (PPK, Post-Processed Kinematics), a commercial license is required.

1 Contact your Delair distributor or sales representative.

2 Select the appropriate license package among those proposed.

3 You can view and check the status of your PPK licenses on MyDelair (https://mydelair.com), the
Delair community platform.

9.1.2 Importing, visualising and processing data

9.1.2.1 Importing the images from the UX11

To import images, prepare the following:

• Windows 10, 64-bit desktop computer with the Delair After Flight application installed.

• UX11 aircraft fuselage

• USB cable

• The computer must be connected to the Internet in order to retrieve or update PPK licenses
for that aircraft. Since PPK licenses are stored on the computer, the Internet connection is only
needed – for a given aircraft - when its PPK license is created or updated.

Procedure:

1 Open the transport bag and place the aircraft fuselage upside down on your desk.

2 Connect the computer to the USB-C connector of the aircraft (using a USB cable).

Windows 10 recognizes the aircraft as an external drive. An icon or a message may be shown on
the computer screen.

3 Launch the Delair After Flight application.

4 Click File > Open flight.

A pop-up window allowing to choose a directory is shown.

Note
Alternately, if the user prefers copying files locally (using the Windows File Explorer to navigate the
external drive, select folders, copy them locally on the computer), the Delair After Flight application
also supports opening a regular folder. It is also possible to drag and drop a flight folder directly onto
the map area to trigger its import.

5 Browse to the aircraft drive. You can see whether or not it contains acquisition data, with the title
of the flights, their date and number of images. Select a directory and click Open.

The imported flight(s) appear(s) on the left panel of the application. Each flight is automatically
given a different color, which is used on the map view and also on relevant pop-up windows, so
that you always know which dataset you are currently handling.

The metadata are automatically loaded by the software. A progress bar is shown during this
process. Position of images are shown on the map as the metadata are loaded.
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9.1.2.2 Processing images for high accuracy (PPK)

If a valid PPK license is found for this aircraft and this flight date, the high accuracy trajectory post-
processing is automatically launched.

You will then be prompted to enter base station data (RINEX files, reference coordinates and reference
antenna offset).

9.1.2.2.1 Select base station files

The application supports base station files as RINEX.

RINEX (Receiver Independent EXchange Format) is a data interchange format for raw satellite
navigation system data. Converting any base station file to RINEX results in a set of files sharing the
same name with different extension.

Observation files (extension .xxO) are mandatory and contain raw observations. They may come
along with several other but optional navigation files depending on supported satellite systems (for
instance .xxN for GPS navigation files, .xxG for GLONASS navigation files). The navigation files should
be included if possible.

The application only supports GPS and GLONASS satellite systems thus a set of RINEX files should
contain an observation (.xxO) and two navigation files (.xxG and .xxN). The software supports using
several observation files from a single base station (it is common for permanent base stations to split
files periodically).

The application supports files from base station antennas calibrated by National Geodetic Survey. A
complete list can be found here https://www.ngs.noaa.gov/ANTCAL/. Latest calibrated equipment may
not be included.

To ensure full compatibility and accurate results, your RINEX files should comply with the following
requirements:

• RINEX version: 2.x or 3.x

• Satellite systems: GPS and GLONASS

• Carrier phase: L1 and L2

• Logging interval: 1s

1 Drag and drop base station RINEX files (supports multiple files at once) onto the base station
window.

A dialog window now shows the list of selected files.

• If you are not satisfied with your selection, just select one or several files to delete from the
list and click Remove.

• You can add additional files by either dragging and dropping them onto that window or
clicking Add and browsing your drive.

• This operation can be repeated as many times as required to add more files.

2 When done, click OK.

The application now shows whether the base station files overlap the same time period as the
flight.
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3 Press and hold down your mouse on the graph, and move the mouse cursor to display the exact
time at each element (base station validity time and flight data).

Note
For a successful high accuracy trajectory post-processing, it is very important for the imported base
station files to fully cover the duration of the flight. For best results it is recommended to record base
station logs for a duration of 30 minutes prior to flight, 30 minutes after flight and a total of 2 hours.

9.1.2.2.2 Set reference coordinates and height offset

The application automatically reads the reference coordinates from the base station RINEX files. This
is usually the value that was set on the base station device when logging started, or it may be an
autonomous, uncorrected position that is not of control quality.

This value may not be accurate. If you are not sure the RINEX file contains the correct value, please
verify the coordinates of the control point and set it manually.

Note
If your base station position is not precisely known, it is required to post-process your RINEX file to get
a precise position. Some websites offer such service for free such as Trimble CenterPoint RTX (https://
www.trimblertx.com/UploadForm.aspx) or OPUS (https://www.ngs.noaa.gov/OPUS/).

1 By default, the previously used coordinate system will be applied to the base station coordinates.
If applicable, select the coordinate reference system tied to the corrected base station position.

The input fields for entering the base station position are updated depending on the chosen
coordinate reference system, and the filled values are automatically converted. If the selected
projection is inappropriate for the base station coordinates, the application displays a
Transformation failed error message.

2 Enter the precise coordinates.

When using a geographic coordinate system, you can enter longitude and latitude either in
decimal degrees or in DMS (degrees, minutes and decimal seconds). In the latter case, the
input field is clever enough to understand a coordinate without the degree, minute and second
symbols. For instance, you may of course type 43° 27' 20.08351" N, but simply entering 43 27
20.08351 N does the job too. References to cardinal points may be entered in English (N, S, E, W)
as well as in the configured language (see Other options on page 72).

Note
If you want to reset the reference coordinates to their initial values as read from the RINEX files, click
Select files and then OK. This will force the RINEX files to be re-checked.

3 Enter the correct antenna height.

The antenna height or antenna reference offset is is the vertical distance between the ground (or
marker if using a known location) and the Antenna Reference Point (ARP).

CAUTION
Any error on the antenna reference offset will shift the whole dataset by the same value on the Z axis.
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The ARP depends on the GNSS antenna model, but is generally the base of the antenna (where
the outside housing of the antenna meets the mount of your tripod) or another physical mark on
the antenna. Check with the manufacturer of the GNSS antenna for details.

9.1.2.2.3 Launch the process

1 Click OK to start processing.

A progress bar is shown during this process.

Once all post-processing is done, the Quality Check is triggered automatically.

Upon completion, all image locations are updated to reflect PPK status according to the legend.

If an issue occurs during processing, a notification appears in the top part of the screen.

2 The process can be re-launched anytime, clicking on the  on a flight.

Note
More documentation on how to get accurate results is available to registered users on (https://
mydelair.com).

9.1.2.3 Selecting and filtering images

1 Default filters are automatically created when a flight is opened.

On the map view, the images filtered out are outlined.

2 At any time, you may click  to see basic information about the flight (full name, takeoff date,
number of images, etc.).

3 Click  on a flight to expand the filters.

• You may click on a filter to change it, disable it or remove it.

• You may also define additional filters.

The Quality Check is automatically triggered again when the selected data set changes.

9.1.2.4 Exporting images

1 When you are satisfied with the applied filters, click on the  Export button in the selection panel
at the bottom of the window.

2 Select a target root folder for your exports (if not already set, otherwise the application
remembers your previous choice).

The application creates a directory tree into which the selected images are copied with the correct
metadata in the Exif/XMP fields.

A progress bar is shown during this process.

3 Choose a mission name as you see fit.

4 Pick a coordinate reference system for the exported CSV files.

5 Pick a coordinate reference system for image geotags.
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Note
Horizontal coordinates in the Exif metadata are always exported as a longitude and a latitude relative
to the WGS84 ellipsoid. Altitude, on the other hand, may be provided as either the height above the
WGS84 ellipsoid, or the height above the EGM96 geoid (default).

6 Select the format and options for exported images, and verify that the estimated export size does
not exceed the available disk space.

7 Click OK to initiate the export.

The application creates a directory tree into which the selected images are copied with the correct
metadata in the Exif/XMP fields.

A progress bar is shown during this process.

8 When done, in the Windows file explorer, right click on the aircraft drive and click Eject.

You can now safely disconnect the USB cable from the aircraft.

CAUTION
It is strongly advised to make backups of the raw flight folders. You should copy the raw flight folders
from the aircraft drive to your desktop computer or any other media for safeguarding, and delete them
only when you are sure to be fully satisfied with the post-processed, filtered and exported datasets.

9.1.3 Configuration settings and options

9.1.3.1 Digital Elevation Model

The application relies on a Digital Elevation Model (DEM) to compute image projections and coverage
maps. It is also used to apply quality checks such as flight height filtering, and to display the estimated
AGL (Above Ground Level) height in the image metadata viewer.

Other than these convenience features, the DEM is not necessary for actual processing and has no
impact on the quality of the exported dataset.

During installation, you are proposed to download DEM files locally. The complete SRTM90 DEM is
about 21 GB, but you may select a subset of it, according to your needs.

If need be, you can update the installed DEM subset in the application’s Help > Options > Digital
Elevation Model menu.

Note

In the application’s Help > Options menu, you may alternately point to the online Delair SRTM90 web
service, but in that case an Internet connection is required during the whole work session. Moreover, Delair
does not guarantee the service to always remain available and up. This service is mostly provided in case
you do not have the local DEM installed for some areas only and are not in a situation where you can easily
download it (for instance, due to limited network bandwidth). Performance importing and processing a
flight dataset may be sub-optimal when the online DEM is used.

Custom DEMs are not currently supported in Delair After Flight. As a result, features such as image
projections and flight height filtering may yield different results than estimated by Delair Flight Deck if a
custom DEM was used.
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9.1.3.2 Coordinate systems

The application supports several coordinate reference systems (CRS).

Cartesian
ECEF (Earth-Centered, Earth-Fixed, also known as ECR, Earth-Centered Rotational), is a
cartesian coordinate frame (X, Y, Z) relative to the Earth's center of mass. Positions in RINEX
files are in ECEF, see Processing images for high accuracy (PPK) on page 67.

Geodetic
Geodetic datums use geographic coordinates (longitude, latitude, altitude), with reference to
an ellipsoidal representation of Earth.

Regarding the longitude and latitude, the geodetic datum may be global (representing the
entire Earth), or local (representing an ellipsoid best-fit to only a portion of the Earth).

Height references may either be based on the ellipsoid, or on geoids (modelling the surface
of the Earth and sea-level globally or locally).

Projected
These coordinate systems are flat, two-dimensional representations of the Earth (easting,
northing, altitude), based on a projection from an ellipsoid representation to a plane.

Regarding the easting and northing axis, the projection may be global (representing the
entire Earth), or regional (applicable to specific local areas only).

Height references may either be based on the ellipsoid, or on geoids (modelling the surface
of the Earth globally or locally).

9.1.3.2.1 Configuring the preferred coordinate system

After installation, the application uses WGS84 (EPSG:4326) with ellipsoidal height as default
geographic coordinate system.

The preferred coordinate system is used for:

• Showing coordinates on mouse position;

• Showing image coordinates and metadata in the Selection panel;

• Setting the default coordinate system for PPK base station settings;

• Setting the default coordinate system for dataset export.

Set your preferred coordinate system as described hereafter.

1 Open the Help > Options menu.

2 Go to the Coordinate system tab.

3 Select a coordinate system type (geodetic, projected or cartesian).

4 For geodetic or projected coordinate systems, select the horizontal and vertical components,
browsing through the list of supported systems or filter them by their name or EPSG code.

9.1.3.2.2 Showing coordinates on mouse position

When the Window > Map decorations > Mouse position configuration option is enabled, the
application displays the coordinates of the mouse pointer when the map is hovered.
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The information is shown at the bottom left of the map view, above the scale indicator. The
coordinates are displayed according to the preferred coordinate system.

Where the Digital Elevation Modem (DEM) is also available, the interpolated terrain height is also
displayed.

Note

Height is not displayed where the local DEM is not available for the displayed area. For obvious
performance reasons, the Delair SRMT90 web service is not used in that case. (See Digital Elevation Model
on page 70.)

The SRTM90 DEM is relative to the EGM96 geoid. If you choose a different vertical coordinate system, the
displayed height therefore includes the offset to that system (and therefore, for instance, might not be zero
at sea level).

Projected coordinate systems and geoids might apply within specific bounds on a local area only, in which
case the projection may be invalid. In such a case, the application displays Transformation failed. Also note
however that some projections may still provide a result while being outside of their bounds, without failing.
The resulting projected coordinates, however, do not represent anything accurate and cannot be used for
any process.

9.1.3.3 Other options

Mesure units

Select your preferred system of units in the the Help > Options > Mesure units panel.

The selected units are used for display in several places (image metadata view, height filtering, etc.).

Note
Altitudes in the application are also displayed depending on the selected coordinate reference system. If the
coordinate system specifies a vertical unit, the latter is used.

Additional measure tools can be enabled in the Window > Map decorations > Measure tools option.
Once enabled, measure tools are accessible via a dedicated button on the map view:

• Measure lengths

• Measure areas (surfaces)

• Measure angles

Language

After installation, the application is configured to use the same language as your operating system, if
supported, or English otherwise.

You can manually set it to any of the other supported languages via the Help > Options > Languages
menu. The language change will then take effect after a restart of the application.

Flight logs

In order to continuously improve Delair products, and to provide the best possible experience to the
user, Delair gathers information on aircraft behavior by collecting and analyzing flight logs.
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Please note that flight logs contain geolocation data (GPS coordinates and time stamps) which might
be considered as sensitive data in some countries. Local regulations may also impose restrictions on
sharing and exporting geographic information.

Delair processes personal data in accordance with the provisions of the EU General Data
Protection Regulation (GDPR). For any information you may contact our Data Protection Officer at
dpo@delair.aero.

Delair Support or Delair-authorized third parties may access these flight logs for product improvement
analysis or troubleshooting issues that might have occurred in-flight.

Flight logs are transferred over an encrypted connection and are kept for a maximum data retention
period of three years.
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9.1.4 Exported formats

After exporting a dataset with Delair After Flight, the following tree structure is created:

OutputFolder/YYYY/MM/DD-MissionName/

Where:

• YYYY, MM, DD correspond to the flight's takeoff date (if exporting several flights
simultaneously, the first one is used);

• MissionName is as manually entered by the user in the export window.

Output folder structure

Several files are created in this folder:

report.pdf
PDF file containing:

• Information on the export (date, name of machine, software version, used Digital
Elevation Model, number of images before and after filtering, image file format, etc.);

• For each exported flight, a summary regarding the dataset, applied filters and other
settings, maximum horizontal and vertical accuracies at 68% and 99% confidence
intervals (applying to both GNSS accuracy and camera position accuracy);

• The coverage map, and PPK solutions (if available).

MissionName.prj
(UX11) Inpho project file for Trimble UASMaster.

YYYMMDD_NN
For each exported flight, a sub-folder YYYMMDD_NN is created (where NN indexes the
flight). It contains:

geometry_filters
Optional sub-folder containing, if any, the polygon(s) used for area filtering, in KML
format.

CameraModelName
For each camera equipping the aircraft, a sub-folder CameraModelName is then
created.

The camera sub-folder contains:

NN_SequenceNumber .tif or .jpg
(UX11) All images taken by this camera, with Exif/XMP metadata.

Coordinates in Exif/XMP metadata are always in WGS84, with either ellipsoidal
height or EGM96 height (default), depending on the choice made by the user at
export.

NN_SequenceNumber_wavelength.tif
(UX11 Ag) All images taken by this camera, with Exif/XMP metadata.
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The file name includes the central wavelength (475nm blue, 560nm green, 668nm
red, 717nm red edge, 840nm near infrared).

Coordinates in Exif/XMP metadata are always in WGS84, with either ellipsoidal
height or EGM96 height (default), depending on the choice made by the user at
export.

NN_metadata-export.csv
Input file in TAB-separated values format for Delair.ai, Pix4D, Correlator3D, Trimble
UASMaster (along with the Inpho project file) and other tools that allow you to
process data in your preferred coordinate system.

Contents depend on the coordinate reference system selected for the export:

• For a geographic coordinate system:

Image name, Longitude, Latitude, Altitude

• For other projected or cartesian systems:

Image name, X/Easting, Y/Northing, Z/Altitude

Coordinates correspond to the camera positions (see below). Length, height and
accuracy units depend on the selected coordinate reference system.

NN_metadata-export.prj
ESRI projection file with coordinate system (WKT) associated with the NN_metadata-
export.csv file.

NN_metadata-export-vdatum.prj
ESRI projection file with vertical coordinate system (WKT) associated with the
NN_metadata-export.csv file.

This file is only generated when a geoid was chosen, instead of the ellipsoidal height
relative to the horizontal coordinate system.

NN_metadata_CameraModelName.csv
Original metadatas in TAB-separated format:

• Image identifier (sequence number);

• Timestamp (RTC);

• Longitude, latitude and altitude (camera positions, see below) in WGS84 with
ellipsoidal height;

• Roll, pitch, yaw angles in degrees;

• Date and time in UTC;

• Shutter and gain;

• Horizontal and vertical accuracy in meters.

NN_CameraModelName.jxl
(UX11) Trimble JobXML file for Trimble Business Center. This file may be used
with either TBC v5.0 or previous versions, however it does not fully support high-
precision (PPK-processed) datasets.
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NN_CameraModelName_TBC5_PPK.jxl
(UX11) High-precision JobXML file for Trimble Business Center v5.0 or newer.
Enabled for PPK-processed datasets, it allows the high-precision horizontal and
vertical accuracy estimates for GNSS positions to be carried through to TBC and
utilized by Trimble’s photogrammetry algorithm.

calibration
(UX11 Ag) Reflectance panel calibration pictures in each of the five bands.

Positions and accuracies in the Exif/XMP metadata and the above-mentioned .csv files correspond to
the camera:

• Camera positions take into account the lever arm offset between the GNSS and the camera in
the aircraft body.

• Camera position accuracies integrate the different subsystem accuracy estimations and are
therefore greater than the raw GNSS accuracy values.

Positions in the Trimble JXL files correspond to the GNSS antenna, and the lever arm offset is provided
to Trimble Business Center, which performs the appropriate corrections.

Image XMP metadata

Besides standard Exif tags, exported images also contain XMP metadata. Delair After Flight exports
at least the following XMP fields:

Field Meaning

Xmp.Camera.Roll Roll angle in degrees

Xmp.Camera.Pitch Pitch angle in degrees

Xmp.Camera.Yaw Yaw angle in degrees

Xmp.Camera.GPSXYAccuracy Horizontal position accuracy in meters

Xmp.Camera.GPSZAccuracy Vertical position accuracy in meters

Xmp.Camera.TransformAlpha (UX11) Alpha parameter for each band

Xmp.Camera.TransformBeta (UX11) Beta parameter for each band

Xmp.Camera.TransformGamma (UX11) Gamma parameter for each band

Xmp.CRSInfo.VERTCRS Vertical coordinate system: set to EGM96 when
altitude is relative to the EGM96 geoid, absent
otherwise.

Images from the UX11 Ag also contain other XMP fields directly inserted by the MicaSense camera.

9.2 Photogrammetry processing

After pre-processing, datasets can be processed in photogrammetry software (such as Pix4D) or
Delair's cloud platform https://www.delair.ai.
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Delair.ai is a cloud-based platform to manage, process, view, analyze and collaborate around aerial
data. Our industry-specific solutions provide the simplicity, security, and scalability that enterprises
require to turn aerial data into business insights.
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10 Maintenance

10.1 Replacing the propeller

Whenever the propeller is broken, or if it shows any dents, it has to be replaced.

Orderable parts:

Part Number This part comprises

FDG-000060 3 × pairs of UX11 propellers and screws

Required tools:

• Torx T10 screwdriver (included in the standard UX11 toolkit)

Required parts:

• 2 × Screw

• 2 × Propeller

Damaged propeller blades can be replaced as follows:

1 Loosen the fixation screw.

2 Insert a new propeller blade.

3 Fix the propeller blade with a new fixation screw.

• The fixation screw should be tightened in a way that the blade can rotate freely.

• Every time the propeller is changed, new fixation screws should be used to ensure that
they still have some thread lock on.
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10.2 Replacing a wing

Every 100 flights, the wings have to be replaced as a preventive maintenance action. The wing should
also be replaced if it shows excessive damage such as (but not limited to): bent or broken wing
tip, damaged push rod, teared elevon horn, noisy servo actuator, broken or deformed plastic part,
damaged elevons (hinge, trailing edge), bent connector pins.

Orderable parts:

Part Number This part comprises

FDG-000055 1 × UX11 right wing

FDG-000056 1 × UX11 left wing

FDG-000033 1 × UX11 right wing

1 × UX11 left wing

Required tools:

• None

Required parts:

• Left wing and/or right wing

Step:

• Replace the part by the new one.

10.3 Replacing the belly plate

Every 100 flights, the belly plate has to be replaced as a preventive maintenance action. The belly plate
should also be replaced if it shows excessive damage such as (but not limited to): torn-off foam beds,
loose fitting with the fuselage.

Orderable parts:

Part Number This part comprises

FDG-000057 1 x UX11 belly plate

Required tools:

• None

Required parts:

• 1 × Belly plate

Step:

• Replace the part by the new one.
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10.4 Replacing the propeller holder

The propeller holder has to be replaced if:

• it is broken,

• it is bent,

• one of the two metallic inserts is missing, or

• it shows any cracks.

Orderable parts:

Part Number This part comprises

FDG-000066 1 × UX11 propeller holder (with 3 screws)

FDG-000067 1 × UX11 propeller holder screwdriver (T6)

Required tools:

• Torx T6 screwdriver

Required parts:

• 3 × Screw

• 1 × Propeller holder

1 Unscrew and remove the old propeller holder.

2 Center the new propeller holder on the motor and rotate it in order to align the three fixation
holes with the ones on the motor.

3 Insert and tighten the 3 fixation screws. The screws should be changed every time the propeller
holder is changed to ensure that they still have some thread lock on.
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10.5 Cleaning or replacing the Pitot tube

Orderable parts:

Part Number This part comprises

FDG-000058 2 × UX11 Pitot tube

Required tools:

• None

Required parts:

• 1 × Pitot tube

1 Remove the Pitot tube.

2 Either simply replace the part, or blow in the static pressure port hole and in the dynamic total
pressure port to make sure they are not clogged.

3 Attach the Pitot tube on the double barbs on top of the fuselage.

10.6 Cleaning the camera lens

Dirty optics can and will affect your image quality. A dirty height sensor lens can lead to incorrect
detection and a fatal crash during landing.

Make sure to clean both lenses before every flight.

Orderable parts:

Part Number This part comprises

FDG-000062 Lens cleaning kit

Required tools:

• Lens cleaning kit (lens brush, air blower, lens cleaning tissue, wet wipes)

1 Remove as much dust and dirt as possible from the lens with the lens brush and the air blower.

2 With the wet lens tissue, using a circular motion, gently remove oil, fingerprints, and grime from
the lens surface, working from the center to the edge.

3 Keep the lens cleaning tissue in clean conditions.
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10.7 Replacing the Delair Link battery

Orderable parts:

Part Number This part comprises

FDG-000068 Delair Link battery replacement kit

• 1 × Battery

• 4 × Screws

• 4 × Bottom feet

Required tools:

• Torx T10 screwdriver (included in the standard UX11 toolkit)

Required parts:

• 1 × Battery

• 4 × Bottom feet

1

2

3

5
4

1 Remove the four old bottom feet (1).

2 Unscrew the four screws (2) and remove the bottom part (3).

3 Unplug the battery connector (5) and remove the old battery (4).

4 Plug and put in place the new battery (4).

5 Put the bottom part (3) back in place and fix it with the four screws (2).

6 Remove the protective film from the new bottom feet (1) and place them on the bottom part (3).
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11 Troubleshooting

FAQ and troubleshooting advice (with our Support team) can be obtained from our Support page
(https://support.delair.aero/).

Useful tutorials can be found on our Youtube tutorial channel (https://www.youtube.com/playlist?
list=PLcPZm4pl0xwH2j919ruzUrC6i_ZKO8x9b)
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Appendix A French CAA Specifics

A.1 Introduction

The UX11 system is certified by the French Civil Aviation Authority ("Direction Générale de l'Aviation
Civile"). A number of features and functions have been added to the system to comply with DGAC's
requirements, they are described in this Appendix.

A.2 Delair Link

Delair Link use is mandatory in France as primary C2 link and the flight range is restricted to 3km
when operating under the S4 scenario.

A.3 Geofence

NOTICE

The country you are operating in may have regulations prescribing the geofence settings that you must use.
In France, for S2 scenario operation, the operator shall:

• Define a height limitation at 150 m the highest,

• Define a lateral geofencing that includes planned operations and which borders are not at more
than 1 km of the operator.

A.4 Communication timeout

NOTICE

The country you are operating in may have regulations prescribing the minimum communication timeout
setting that you must use. Make sure you are aware of these and that you use the regulated minimum
setting for your location.

In France, for S2 scenario operation, it is mandatory to set the communication timeout to 5s ; for S4
scenario operation, it is mandatory to set the communication timeout to 30s..

A.5 Flight Termination System

NOTICE
In France, for S2 or S4 scenario operation, it is mandatory to perform the FTS test before each flight.
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A.6 Margins applicable to populated areas

For operations in France (when operating under S2 or S4 scenario), the following margins to
populated areas must be applied:

    Flight height (m)

    100 110 120 130 140 150 160 170 180 190 200

0 170 170 180 190 190 200 210 210 220 220 230

1 180 190 190 200 210 210 220 220 230 240 240

2 190 200 210 210 220 230 230 240 240 250 260

3 200 210 220 220 230 240 250 250 260 260 270

4 210 220 230 240 240 250 260 270 270 280 280

5 220 230 240 250 260 260 270 280 290 290 300

6 230 240 250 260 270 280 290 290 300 310 320

7 240 250 260 270 280 290 300 310 310 330 340

8 250 270 280 290 290 300 310 320 330 350 370

9 270 280 290 300 310 320 330 330 350 370 390

10 280 290 300 310 320 330 340 350 370 390 410

11 290 300 310 320 330 340 350 370 390 410 430

Wind speed
in the
direction of
populated
areas (m/s)

12 300 310 320 330 350 360 370 390 410 430 460
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